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Creating Web Pages Using MS FrontPage

Who Sets the Standards? The World Wide Web

Consortium (www.w3.0rq)

The World Wide Web consortium is the governing body for the Web. It performs
research and training activities and publicizes changes and enhancements. It is committed
to making sure that the Web is always available no matter what computer, operating
system, browser etc. anyone is using. (Netscape and Microsoft must submit requests for
changes or enhancements in standards to this organization.)

Internet: The largest public
Wide Area Network
Intranet: a private Wide Area
Network, with access restricted to
only those within an organization
Extranet: A private Wide Area
Network for a group of companies
or organizations

World Wide Web: A huge
collection of HTML documents
that link to other documents
Web Server: the computer that
holds a Web site, along with the
software that lets the computer
serve the site to another comp
> Web site: group of HTML fil
r  Web Page: one of these
documents; one file

Internet/Intranet/Extranet/World-Wide Web??

Components of a Web Site
A Web site isaway to convey information to others electronically. In order to see the
Web site, you must have:

* A Browser. Thisis asoftware package that trand ates the Web software into images
and text you can see. The two biggest browsers are Netscape, either Navigator or
Communicator, and Microsoft’s Internet Explorer. Either can be obtained for free.
Netapp supports both Netscape and Internet Explorer, and you must check out all Web
pages on both to ensure they can be viewed by everyone.

* A connection to the Internet. We have aT1 line, which is adirect connection with
the Internet and the fastest. At home, you may use an ISP such as America Online
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(AOL), EarthLink, , or dozens of other ISP’s, or you may have a cable or DSL
connection. Your computer needs amodem if you dial up via phone lines.

* AnInternet site, or External Web site, is one that can be viewed by everyonein the
world with access to the Web. An Intranet or I nternal Web site, however, isviewable
only within a particular company, and is protected from the outside world by a
firewall.

Basic Web Page

All you need to create a basic web pageisan HTML document. Y ou can add alot of
features, of course, but an HTML document is required. Y ou can use Notepad, vi, or
free packages such as Arachnophilia (download at www.arachnoid.com) to create
HTML documents.

If you don’t want to learn HTML, you must use an HTML editing package, also called
WY SIWY G (What you seeiswhat you get) editor. These include Dreamweaver,
PageMill, HomeSite, Go Live, and Front Page

Documents

If you want to include documents, they must either be in HTML format, or you can
use Adobe Acrobat Writer to convert any Word or Excel document into .pdf format.
Thisformat amountsto a*“ picture” of your document. Anyone needing to view a .pdf
document must have Adobe Acrobat Reader installed on their computer. Y ou can go
to Adobe.com and download the reader from there. However, to write Adobe Acrobat
documents, you need adobe Acrobat Writer software, which costs around $180. Note:
Y our software may allow you to put Microsoft Office documents on your page, but
they won't be readable by Netscape, Mac, or UNIX users. (Go to
http://web.netapp.com/engineering/webresources/docs.html for more information.)

Other Items

Common Gateway Interface (CGI), Server Application Program Interfaces
(API's), Client-Side Scripting, Client-Side Objects

These are programming objects that allow your Web site perform more elaborate
transactions.

Monitoring Applications

These are items such as WebTrends, which allow you to keep track of the number of
visitors to you r site, etc. Y ou can write a program to do this, or use an aready written
small application ("applet").

Web Graphics

There are two types of computer images. Vector and Raster. Vector images are made up
of lines, and Raster images are made up of little dots, or pixels.
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Computer screens are made for raster-based images, so vector-based images don't display
as easily onscreen. The three file-types used on the Web, PNG, JPG, and GIF are all
raster-based.

Web Graphics File Types

PNG (Portable Network Graphic)

Thisformat was created by a consortium of graphics tools developersand is
relatively new. Adobe PhotoShop can write them and Microsoft Internet Explorer).

Here's a portion of the W3C recommendation:
1. Introduction

The PNG format provides a portable, legally unencumbered, well-compressed, well-
specified standard for lossless bitmapped image files.

Although the initial motivation for developing PNG was to replace GIF, the design
provides some useful new features not available in GIF, with minimal cost to
developers.

GIF features retained in PNG include:
» Indexed-color images of up to 256 colors.

» Streamability: files can be read and written serialy, thus alowing the file format
to be used as a communications protocol for on-the-fly generation and display of
images.

* Progressive display: a suitably prepared image file can be displayed asit is
received over acommunications link, yielding alow-resolution image very
quickly followed by gradual improvement of detail.

» Transparency: portions of the image can be marked as transparent, creating the
effect of a nonrectangular image.

* Ancillary information: textual comments and other data can be stored within the
imagefile.

* Complete hardware and platform independence.

» Effective, 100% |lossless compression.

Important new features of PNG, not available in GIF, include:
» Truecolor images of up to 48 bits per pixel.

» Grayscaleimages of up to 16 bits per pixel.

* Full aphachannel (genera transparency masks).

» Image gamma information, which supports automatic display of images with
correct brightness/contrast regardless of the machines used to originate and

display the image.
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* Rédiable, straightforward detection of file corruption.

* Faster initial presentation in progressive display mode.

PNG is designed to be:

» Simple and portable: developers should be able to implement PNG easily.

* Legaly unencumbered: to the best knowledge of the PNG authors, no algorithms
under legal challenge are used. (Some considerable effort has been put into
verifying this.)

*  Well compressed: both indexed-color and truecolor images are compressed as
effectively asin any other widely used lossless format, and in most cases more
effectively.

» Interchangeable: any standard-conforming PNG decoder will read all conforming
PNG files.

* Hexible: the format allows for future extensions and private add-ons, without
compromising interchangeability of basic PNG.

* Robust: the design supports full file integrity checking as well as simple, quick
detection of common transmission errors.

The main part of this specification simply gives the definition of the file format. An
appendix gives the rationale for many design decisions. Although the rationale is not
part of the formal specification, reading it can help implementors understand the
design. Cross-references in the main text point to relevant parts of the rationale.

(http:/wvww.w3.or g/TR/WD-png-960221.html)

GIF: Graphics Interchange format

GIF isagraphicsfile format developed by CompuServe. The advantages of GIF files
include:

» Small file sizes. GIF gives you only up to 256 colors. At thetimeit was
developed, monitors couldn't do better so it made sense.

e Built-in compression.

* Transparency. PNG does this better; Jpeg doesn't do it at all. Animated GIF, or
GIF894, isthe easiest and cheapest way to animate a Web page.

JPEG: Joint Photographer's Experts Group

JPEG now refers to both the file format and to a set of techniques for compressing
data. Thisisamost always what photos are stored in . JPEG's are really bad at
handling type and line art.

Advantages:

» Great compression
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» Progressive display: you can see the image being built as it downloads, rather
than seeing the compl ete image pop up after the whole image has been loaded by
the browser. (similar to Interlaced, except a Progressive image loads from top to
bottom, rather than starting blurry and then coming into focus.

Loading Images
The more information an image contains:

» The more storage space the image requires
» Thelonger the image takesto transfer over an Internet connection
* Thesdower theimage is handled in an image-editing applications

Monitors

Monitors use Phosphor Dots to show what's on the screen. Dot pitch refersto the
distance between Phosphor Dots on amonitor. The lower the better. Monitors are
limited to a particular resolution, such as 640x480 or 600x800. The highest so far is
1600x1200.

Pixels

The basic building block of images on a screen is the pixel, which stands for "picture
elements." The highest resolution (greatest no. of pixels on a screen) commonly
viewable by amonitor is 1600x1200. A pixel must contain a complete set of red,
green, and blue dots to create a full range of colors, and ideally, each pixel contains
exactly one set of dots.

The size of the pixels depends on the video card, how the hardware is configured,
and the size of the monitor.

* Most Mac monitors display about 72 pixels per inch. Thisis the same as one
printer's point long and one printer's point tall.

* Most PC system monitors display about 90-100 pixels per inch.

* Thenumber of pixelsthat a monitor screen displaysis called the screen's
resolution and most monitors on both platforms display images at varying
resolutions. In other words, resolution isn't built into the monitor; it's built into
the video card.

Color Models
Colors can be described in a number of ways. Here are afew you may hear about:

Pantone

Thisisaprinting convention in which colors are given names like PMS 130. The
numbering has no pattern, though, and you have to look up colors in a swatchbook.
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RGB

I ndividual pixels are made up of red, green, and blue phosphor dots. These colors
are the basis of the RGB system. The color's value is defined by three numbers: the
first indicates how much red isin the color, the second defines how much green, and
the third indicates how much blueisin the color. RGB colors are predictable,
computer-friendly, and the language of the Web. HTML, Cascading Style Sheets
and all other Web standards use RGB to specify colors.

CYMK

This color specification system is based on the ink colors used in four-color printing:
cyan, magenta, yellow, and black (K, which stands for key.) Values are measured
in values from O percent to 100 percent. Because colors must be converted to RGB
for use by computers, it's not efficient for computers. It's meant for doing prepress
work on images to be printed.

HSB
Hue, Saturation, and Brightness.

* Hueisameasurement of the color's position on the color wheel and isusually
what we mean when we say "green".

e Saturation isameasure of how "pure" acolor is. As colors are less saturated,
they become more gray.

» Brightnessrefersto the clarity of acolor.

Resolution
File Resolution is a measurement of the amount of information that an image file
contains. Monitor screen resolution is the amount of information that the monitor
can display.

Sync rate is ameasurement of how often the video guns in the monitor can redraw
the screen. When there are more pixelsto draw, it takes longer to draw them and the
sync rate has to be reduced. If the sync rate gets too low, the screen appearsto
flicker.

72 dots per inch (dpi) isthe standard for PC's, though some are greater.

Bandwidth

Bandwidth is actually the width of the "pipe" used to transport data, but it's come to
be used for the size of a page. Size means the amount of disk space required to store
the page on disk, or the amount of RAM memory used to display the image, or the
amount of time that the page takesto load in a browser. A web page's bandwidth is
measured by adding the size of the HTML document, the images, any multimedia
sounds and videos, and objects such as Java applets or ActiveX controls.
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I mportant! If you import a graphic into aweb page, you should check first to see
how large thefileis. If it's over 50-60 KB it's too big. And when you make your
graphic smaller using FrontPage or Page Mill, you don't decrease the file size. You
have to go into graphics editing software (M S Image Composer, PhotoShop, MS
Photo Editor etc.) to do that.

Naming Conventions
Using any Microsoft/Windows application, you used to be limited to 8 digit file name
with no spaces. Now, you can use file names of up to 256 characters and you can use
spaces

However... the Web world limits your choices if you're using UNIX servers... which
we are. So please, don’t usereally long file names and don’t use spaces, for either
your filenamesor folder names.

Also, FrontPage by default uses the extension .htm. Thiswill work for you, but just
keep in mind that most of the other files end with .html. In line with this, you will
need to see the file extensions in Makita so you will link to the correct name. Go to
My Computer or Windows Explorer. Then go to Tools=Folder Options, select
the View tab, and uncheck Hide File Extensions.....

Y ou will name the first page of your siteindex.htm or index.html.

Creating a Web

Site Creation Overview
Here's the bare-bones process:

1. Map your computer to the Web Server (for engineering, map it to thefiler,
Makita.)

If you're using Perforce, get a Perforce client set up on your machine.
Set up folders on the Web server to hold all the files you'll want on your page.
Draw apicture of all the pagesin your site and how they'll link together.

a b~ w DN

Design your main pagein HTML. Y ou can either do the HTML programming
yourself, or you can use atext editor such as PageMill or FrontPage.

Add graphics and a background, if desired.
Create the other pages in the same way.
Link the pages together.

© ®©® N o

Add whatever else you want, such as PDF documents (Y ou can create these
by converting any Word, Excel, or PowerPoint document.)
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10. Check out your Web page in both M S Internet Explorer and Netscape. The
appearance can be quite different depending on the browser, but most Netapp
users are using one of these two.

11. Check it out on the Linux system in our quality control lab.

FrontPage 2000: Introduction

FrontPage 2000 is an all-in-one publishing tool that's used by large and small companies
aswell asindividuals. It allows you not only to create pages, but you can use it to publish
Web pages to the Internet, generate tracking reports about the pages, and administer asite
on the Net. (In our case, however, administration is done by our systems administrators
on our individual servers.)

Here are the basic functions;

e HTML editor
*  Web site builder
* Image editor

* Web site publisher
* Web site manager

+  Source control manager

How is 2000 Different From Other Versions?
The changes in FrontPage are much more dramatic than the other products.

» Prior versions of FrontPage used to change the code of imported HTML
documents created by other editors. This was always one of the major objections
to using it. FrontPage 2000 no longer does this.

* FrontPage 98 had 2 separate programs, the Editor and Explorer programs.
FrontPage 200 integrates the two. Much easer to use.

* FrontPage 2000 much more cleanly mirrors the look and functionality of Office
2000, making it easier to learn.

» FrontPage 2000 has greatly enhanced collaboration features.

* You can now seethe HTML tags while till in the regular page view.

» Useof Cascading Style Sheetsisvastly easier.

* FrontPage 2000 is included with one version of Office 2000 and shares linksto
the other applications with Microsoft OLE and ActiveX controls. OLE and
ActiveX are technologies that are embedded in Office and Windows. OLE isan
interchange format that allows Office programs to share a common language,
while ActiveX us a series of Windows interface commands that enable Web
buildersto call genera Windows applications such as the Media Player or another
application.

* Pixel precise positioning of objects on Web pages

» Addition of the Microsoft Script Editor, a JavaScript and VB (Visual Basic)
Script tool.
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» Automation of tasks, such as updating hyperlinks within a Web site.
* Browser-specific targeting for Web page content
* New and customizable Web site themes

Before you Start...

Install HTML Tools (if you want)
You'll get this:

Microsoft FrontPage® HTML Tools allow you to quickly access and modify Hypertext
Markup Language (HTML) tags directly while you're editing a page in WYSIWYG view
(the Normal tab in Page view). Using HTML Tools is like having X-ray vision for your
Web pages.

http://officeupdate.micr osoft.com/2000/downloadDetails/fphtml.htm

Other updates, tips etc.: http://officeupdate.microsoft.com/wel come/frontpage.aspd
FrontPage 2000 tutorial: http://office.microsoft.com/2000/downloaddetail /FPT utor.htm

Configure FrontPage 2000

1. Click Tools=»Options.

2. Onthe Genera tab, configure as shown if you want. If you check the two other
boxes under Startup, it will mean that Office documents and Web pages will
always be opened with the applications that created them (I don’t always want
this.)

.

[
[
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3. Click Configure Editors. Note that | set up PhotoShop as my graphic editor...
(see below). Y ou must use a graphic editor of some sort to change graphics; Front
Page doesn’t do this. Depending on the version of FrontPage you have, you may
have Image Composer or Photo Draw. Or Office comes with MS Photo Editor;
you can use that. Click OK.

General Configure Editors | Reparts "-.-"iewl

A,

Type | Editer = dd
zhtm FrontPage [frontpg.exe]

ghtrml FrontPane [frantpg. exe) Modify...
gk FrontPage [frontpg.exe)

bt FrontPage [frontpg.exe) Remove
htt FrontPage [frontpg.exe)

azp FrontPage [frontpg.exe)

ciE FrontPage [frontpg.exe)

cdf Test Editor [notepad.exe)

inc Text Editor [notepad.exe)

. Teut Editar [notepad.exe)

aif Phaotozhop [Photozhp.exe)

(]| Phaotozhop [Photozhp.exe) —

| | Bl

[~ Open web pages in the Office application that created them

(] I Cancel |

4. Finally, click Tools=»Options and click the Compatibility Tab. Y ou must
choose both Internet Explorer and Netscape as browsers, because we use both.
Choose 4.0 browsers and later. Choose Apache server, and uncheck the box
next to Enabled with Microsoft FrontPage Server Extensions. Then click OK.
Thiswill gray out some of your options, but thisis OK because they wouldn’t
have worked with the servers we use.
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Page Options

B

Both Internet Explorer and M avigatar

4.0 browzers and later |_

Apscheserer ]
r

R0

The View Bar

The view bar, shown below, lets you view your web in six possible ways.

Page View

The iswhere you build Web pages. Y ou can review a Web page in three ways: Nor mal,
drag and drop visual HTML editor; HTML view; or Preview, which mimics the Internet
Explorer Web browser.
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Hame

TEGNT I Eovamnn s Fir TAR MO Bl o B | 0 adend iy oty |l i |

Frackpleas 1 1, "1' erirar e

Folders View

Thisview displays atypical Windows 98 Explorer menu, allowing your Web project's
filesto be easily accessible within Front Page.

TR ]
ST 31

T
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Reports View
site. Or not working.

Thisview gives you a Site Summary, a bird's-eye view of what's working within your

=5

P S T R - g 5 1 . N
rmil

Vi r-Som sy i sl byl e s e or-ory " ey
W R N T ] L Ae =l

e By S
T U -
R L e T

T B o ] L B o e - 0 B

Navigation View

Thisview provides avisual representation of all the pages on your Web site and the
them.

pages hierarchical order. Y ou can change the relationships of the pages by dragging

F:\engineering\webresources\frontpage.doc
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Hyperlinks View

Thisview gives you a graphical representation of how every Web page connects to every

other page within your Web site. It also shows which pages are linked to sites outside

your own.

Tasks View
This view enables you to assign tasks to individuals on a team, check the status of tasks
that are underway, and manage workflow. (Y ou wouldn’t use thisif you were not
working on the site as ateam.

F:\engineering\webresources\frontpage.doc 14



Margie Metzer F:\engineering\webresources\frontpage.doc
(408) 822-3185; margie@netapp.com

Other Features
»  Spell checker and Thesaurus

* Visua Basic Editor

» Image Composer for editing graphics (Note: Image Composer comes with the
version of FrontPage that is sold separately, not with the version that comes with
MS Office 2000. It ison Disk 2.)

Getting Help

Help Library
Help=2>Microsoft FrontPage Help=»Contents. Or press F1.

Answer Wizard
Help=2>Microsoft FrontPage Help=2>Answer Wizard.

Online Help
If you're on the Internet, go here:

Help=>Office on the Web

FrontPage 2000 Editor (Page View)

Normal, HTML, and Preview Modes

* Normal: the visual editor for Web development. In this view, you can place text,
graphics, applets etc. on screen and FrontPage creates the HTML.

e HTML: dlowsyou to edit the HTML code by hand.

* Preview: Enables you to see what your pages ook like in Internet Explorer before
you put them up. Don't forget to preview the pages in Netscape as well, though,
since our UNIX users have to use Netscape.

Creating a New Web

When you start FrontPage 2000, the program creates adefault HTML page called
New_Page 1.html But you want to create one of your own, so ignore it and do this:

1. Choose File=» New=>Web. You'll get the New dialog box.

2. Enter thelocation for your new Web in the Options area.

3. Select atype of web from one of the templates. The default is One Page Web.
4. Click OK or press Enter to create your Web.
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Setting This Web to Open in Startup
Choose T ools=»Options

2. Sdect the General tab

3. Select the check box next to Open Last Web Automatically When FrontPage
Starts.

4. Click OK.

Note: When you create a Web, FrontPage 2000 also creates an | mages folder and a
Private folder. Put your images in mages. Private is where FrontPage puts the

majority of its automatically generated code.

Template Features
Template Description

OnePageWeb | Includes asingle Web page.

Corporate Includes pages for products and services, feedback, and
Presence searching, plus pages for mission statements and contact
Wizard information.

Customer Includes the tools necessary for building acompelling
Support Web customer support site, including pages for discussion groups,

FAQ's, bug-list reports, a searchable database, and bulletin
board postings.

Discussion Web | Includes search forms, a discussion area, and user registration.

\AS: .. ]

F:\engineering\webresour ces\frontpage.doc 16



Margie Metzer F:\engineering\webresources\frontpage.doc
(408) 822-3185; margie@netapp.com

Template Description

Wizard

Empty Web Includes only the empty default folders.

Import Web Walks you thought the process of importing an existing Web

Wizard into anew Web.

Personal Web Includes a home page, plus pages for a photo album, your
personal interests, and your favorite sites on the World Wide
Web.

Project Web Includes such things as schedul es, task status, discussion

pages, and team-member information.

Creating an Empty Web Page

In addition to the method you just saw, you can create a new empty Web pagein four
other ways:

* From the File menu: File=»New=>»Page. Choose Nor mal Page and click OK.

* From the Standard Toolbar: Just below the file menu is the New Page toolbar
button. Click it.

* From thefolder List: Any timethe Folder List isactive, right-click ablank part
of the Folder List and choose New Page.

* Fromthekeyboard: Press Ctrl+N, select Normal Page, and click OK.

* Your new pagewill becalled New_Page 1.

Creating a Web Page from a Template

There are 25 different templates you can use. To use them, in Page view, press Ctrl+N or
File=»New=>Page to open the New dialog box.

Web Page Template Features

Bibliography Creates a page with entries in the correct form for a bibliography.

Confirmation form | Creates a customer service reply page for users to submit a query.

Feedback Form Provides aform for submitting and receiving feedback.

Form Page Wizard | Creates a customized page with aform that Web surfers can
submit.

FAQ Includes a blank table of contents and links to major sections (you
get to fill themin.)

Guestbook Creates aform that visitors can use to post comments to your
Web site.

Narrow, L eft- Creates a single-column page with text on the left-hand side and a
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Web Page Template

Features

aligned Body

picture on the right-hand side.

Narrow, right-
aligned Body

Creates a single-column page with text on the right-hand side and
apicture on the left-hand side.

One-column Body

Creates a page with asingle column in the middle, atitle at the
top, and some default text down the middle of the page.

One-column body
with Contentsand
Sidebar

Creates atext column in the middle, a picture on the right, and a
blank menu on the left.

One-column Body
with Contentson
L eft

Creates a side text column along the left and a blank menu on the
right.

One-column Body

Creates atext column on the right, with staggered menus on the

with Staggered left.

Sidebars

One-column Body | Creates atext column in the middlie, a smaller text column on the
with Two Sidebars | right, and a staggered two-column menu on the left.

One column Body
with Two-column
Sidebar

Creates one text column on the left, one column of imagesin the
middle, and a blank menu on the right.

Two-column Body

Creates two text columns and a header at the top.

Two-column Body
with contents and
Sidebar

Creates two text columns in the middle, atext sidebar on the
right, and a blank menu on the | eft.

Two-column Body
with contentson
L eft

Creates two text columns to the right and a blank menu on the
left.

Two-column Body
with Contentson
Right

Creates two text columns to the left and a blank menu on the
right.

Two-column
Stagger ed Body

Creates two offset text columns down the middle of the page.

Two-column
Stagger ed Body
with Contents and
Sidebar

Creates two offset text column down the middle of the page, with
ablank menu on the |eft and a sidebar o n the right.

User Registration

Includes a default set of text fields for registering new visitors to
your Web site
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Web Page Template Features

Wide Body with Creates asingle, wide text column with headers interspersed after
Headings every paragraph of text.

Sear ch Page Creates a search form with instructions

Table of Contents | Creates a set of topics and built-in links for your Web pages.

Three-column Body | Creates three columns and a header at the top.

Creating Framed Web Pages

Note: be aware that some people find frames really annoying and that not all browsers
support them. Older versions of |1E and Netscape don't.

Framed Web pages are pages that allow you to scroll down, while amenu at the top
doesn't move and the scrolling page "disappears’ beneath the menu. These are easy to
create, because in HTML, you can display more than one Web page on-screen at the
sametime. To create framed Web pages, do this:

1. InPage View, select File=» New=>»Page from the menu bar. Y ou'll see the New
dialog box.

Giermrnd Frame: Fage: | Side Shasts |
@ o) 9] 8] 8] [
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Humclar Howontel  Meded  Toplioen Yedcs Scll Consias sk i o Hes bap, with
Hyperinkex

Frsodan a1 Spl Hmucty Harachy 3 el i
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[T
Fievion
—
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2. Select the Frames Pages tab.

3. Click the style of the framed Web page you want. After you click a style, you'll
see athumbnail preview at the bottom-right corner of the dialog box.
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4. Click OK. You'll see apage that doesn't necessarily look the way it will when
done. (See below.) You'll see acontrol page and you have to select the pagesin
the frame. Within each framed area you'll see three long buttons, which you'll use
to select the pages you want.

ISR T )
¥ Lot

LhH |

L
*
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a1
=
g

THITHHHL

| Mfooceo SNTREAM R
5. Double-click Set Initial Page to select a page aready in your Web to put there.
6. Double-click New Page to create a new, empty HTML page to go there.

Importing Webs and Web Pages

You can import asinglefile (HTML page, graphic, video, script etc.) or, your can import
the contents of an entire folder. Or, you can import an entire Web. It can be on your
computer, local network, another FrontPage web, or a site on the World Wide Web.

1. From Page View, from the Folder list, click once at the top level, then right-
click to choose New folder. (do this only if you want to create a new Web.)

2. Right-click the new folder to renameit, then right-click it again to Convert to
Web.

3. Now goto File=»Import to get the Import dialog box.

F:\engineering\webresour ces\frontpage.doc 20



Margie Metzer F:\engineering\webr esources\frontpage.doc
(408) 822-3185; margie@netapp.com

4. Click From Web to seethe Import Web Wizard.

liripoit 'Weh Wizard - Chioose Source

5. Now you'll find the location of the Web you're importing. If you choose From a
Sour ce Directory, a Browse button appears on-screen and you go find it. If you
choose the From a World Wide Web Site button, the wizard provides afield
for you to enter the URL.

6. Click Next to bring up the Choose Download Amount dialog box.

7. You can limit the size of the Web you want to download by choosing from the
check boxes. They let you specify the number of layers of the Web you want to
import, and the size in kilobytes of the Web you're importing.

8. Click Next and you'll get the Finish dialog box; click Finish and take a break.
This takes afew minutes.
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Naming Your Web

By default, FrontPage calls anew Web "My Web." And after you name your
Web, changing the name can be a hassle. Y ou name a Web in the New dialog box
in the Options area. In the Specify the L ocation of the New Web field, type a
new name and click OK. Then FrontPage will create afolder with that name and
put the Web contents in the folder. It is recommended that you use short file
names because many servers on the Internet require them.

Opening Files
FrontPage recognizes these types of files:

Web files (HTML, Active Server Pages (ASP), Cascading Style Sheets (CSS),
JavaScript, and VB Script files.)

All Microsoft Office file formats (Word, Excel, PowerPoint and Access) back to
Version 2.x.

Text files

Rich Text files

Word Perfect file going as far back as WordPerfect 5.x.
L otus 1-2-3 spreadsheets going back to Version 1.x.
To open afile, do this:

Choose File=»Open.

Select the file type you want from Files of Type.
Usethe Look In drop-down list to find the file.

A WD P

Click the name of thefile from the list and click Open.
Notice that FrontPage opens the application first, then the file in the application.

If you can't find the file, click the Tools drop-down list (top, right) to search. Or
you can open afilein anew window by clicking the down arrow on the right
side of the Open button. Choose Open in New Window.

Retrieving Recent Webs and Web Pages

Choose File=»Recent Files®»name_of_file.html. Or, choose File=»Recent
Webs2Name _of Web.

Y ou can set your options so that FrontPage automatically opens whatever Web
your were working on last time:

1. Choose Tools=Optionsto open the Options dialog box.
2. Select the General tab.
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3. Select the Open Last Web Automatically when Front Page Starts check
box.

4. Click OK.

Saving Web Pages
* Choose File=» Save.
» Click the Save button on the Toolbar.
* PressControl+S

» If you haven't saved thisfile at all, the Save As dialog box appears. From here,
you can name the file and choose where to saveit.

Saving an HTML file as a Template
If you want to use a page as atemplate, here's how to saveit:

1. Choose File=»Save As. The Save As dialog box appears.

2. Inthe Save In drop-down list box, select the Front Page 2000 Template
directory, usually c:\Program files\Microsoft Office\Templates\1033\pages

3. Select FrontPage Template (*.tem) from the Save as Type drop-down list.
4. Click Save.

5. If there are embedded graphics or other files, you'll be asked which onesto save.
Choose and click OK.

Using your Template
1. Goto File=»New=>Page.

2. Now choose the template you just saved. Remember, it shows up by itstitle and
not the filename. Y ou'll get a new page that looks like your template.

Saving a Duplicate Version
Use Save As and give it anew name to save a duplicate of your file.

Working with FrontPage 2000

Applying a New theme to a Web
1. Choose For mat=>theme to open the Themes dialog box.

2. Click the theme that you want. The four check boxes give you options:
* Vivid colors: Users more vibrant colorsin graphics and text.

» Active Graphics: creates more interesting and dynamic graphics for elements
such as a banner.
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» Background Picture: Adds abackground image to the pares.

* Apply Using CSS: Uses Cascading Style sheets instead of HTML to create
your text and graphics styles.

3. Select the options you want and click OK.

Shared Borders

FrontPage allows you to put an element at the top or bottom of every page, such asa
logo. Thisfeature is called Shared Borders. To use this feature, you designate a
region of a Web page as shared and then make changes to that region on just one
page. FrontPage will make the changes on all the other pages with the shared border.

To assign a shared border:

1. Click thefoldersicon inthe Views Bar to access the folders View. Or if you
want to remain in another view, choose view=>folders to access the folders
List.

2. Select the pages that you want to have shared bo4rders by holding down the
Ctrl key and clicking each page once. Note: If you've just started a Web,
create a bunch of blank pagesfirst and select them all to apply a shared
border.

3. Choose Format=»Shared borders. You'l get this box:
4. Inthedialog box above, select the region or regions you want to be shared across

Shared Borders il |
Apply to:
& Al pages
" Current page
¥ Top
™ Include navigation buttans
[T Leit
™| Ielude navigation Buttors
[~ Bight
[~ BEattom
™| Eeset borders far cunent page baweb default
] I Cancel |

the pages. If it should be applied to all pages in the Web, select All Pagesin the
Apply To area.

5. Click OK.

6. If you make any changesto any of the pages, it will appear on al the shared
borders pages.
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Checking Spelling in the Web

1.

From Folders View, choose Tools= Spelling. You'll get the Spelling dialog
box. Or you can press F7.

Choose whether to run a spell-check on the Entire Web or Selected Pages.

8. Select Add a Task for Each Page with Misspellings check box to turn the

mistakes into tasks.

Click OK. You'll get areport on all pages that contain spelling errors and the
number. Double-check the first page to start fixing or ignoring the misspellings.

Copying files to a Web

Resize your Front Page window so you can toggle between your desktop and the
application by pressing Alt+Tab.

Open Explorer and find the file you want to move into FrontPage. Resize the
Explorer window so you'll see both the file and FrontPage folders.

Using your right mouse button, drag the desired file into the Folder List window
in FrontPage and drop it in the folder you want. Choose Copy or Move, or
Cancel.

Creating folders

Go to Folders View and choose File=»New=>»Folder. Y our new folder isin the
directory that is currently selected. Type a new name. Press Enter.

Or.... From any other view, choose View=>Folder List. Then right-click the
folder in which you want to put the new folder and choose New folder from the
pop-up menu. FrontPage creates the new folder and |ets you change the name.
Press Enter.

Deleting files and folders

Delete from the Folder List: Click an item and press Delete.
Delete from Folder View: : Click an item and press Delete.

Delete from Reports Menu: Y ou can delete HTML pages on which you generate
reports. Click the HTML page in areport and press Delete.

Delete from the Navigation View: On your computer, locate the page you want to
delete and press Delete. Select Remove this Page and all the Pages Below It
from All Navigation Barsto keep the page in the Web but delete dl linksto it.
Or, select Delete this Page and all the Pages Below It from the Web to
eliminate the page entirely.

Deleting from Hyperlinks View: Select the page and press Delete.
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» Deletefrom drop-down lists: Whenever you have afile selected, pressthe Delete
key or choose Edit=»Delete.

Note: You can't undo deleting a page from the Web! Y ou should strip the page out of
the Navigation View first to see what kinds of repercussions your action will have,

then delete it later.

Editing a Theme
Choose For mat=» Theme to open the Themes dialog box.

Click the theme you want.

Click Modify

Choose what you want to change: Colors, Graphics, or Text.
Make your changes.

o g & W DN PR

Click Save to save the changesin the theme, or Save Asif you'd like to leave the
original theme alone and save this as a new theme with a new name.

Edit colors:

* Changecolor scheme: there are 55 different color combinations you can
apply to atheme, or you can make one up. (Custom).

* Changethe Color Whedl: If you select the Color Whesl tab, you can assign a
primary color to the theme from more than 32,000 RGB colors. FrontPage
will then reassemble the rest of the theme based on your primary color
selection. You can also use the slider bar to adjust the brightness by dragging
it to the left (dimmer) or right (brighter).

» Choose Custom Settings: Each theme is made up of 14 color properties,
which apply to hyperlinks, body text, etc. Y ou can modify these by selecting
the Custom tab in the M odify Theme dialog box, selecting the element, and
assigning a color from the Color drop-down list.

Edit Theme Graphics

If you click the Graphics button in the Themes dialog box (For mat=» Themes=
Modify=» Graphics), you can edit the graphics properties which apply to
banners, buttons, etc.:

1. Choose the graphic property that you want to edit from the Item drop-down
list of the Modify Theme dialog box for graphics.

2. Select the Picture tab to edit the graphic you're using for the specific there
element that you want to edit. Some elements contains more than one
embedded graphic. Y ou can add your own graphics manually or use the
Browse button to find the location of the graphics file that you want.
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3. Select Font to edit any text properties associated with your graphic. If the
item is editable, you'll get choices such asfont type, Style, Size, horizontal
Alignment, and Vertical Alignment. (Keep in mind that the browsers support
very few font types: Arial and Times New Roman are supported by almost
every computer.)

4. Select either the Normal Graphicsor Active Graphics radio button at the
bottom of the dialog box. Active graphicslook more like 3D.

5. Click OK twice.

Finding things in Your Web

Y ou can use FrontPage's Find feature to find something in either an individual file
or the entire Web.

1. Activatethe Folder List by choosing View=»Folder List. Or go to the
FoldersView.

2. Select the folder in which you want to do the search. To search the entire
Web, choose the root directory file folder. The root directory file folder's
name is the same as your Web.

3. Click Edit=»Find. You'll get this box:
B Find K E3

Find what: | EEGE | FEind Mesxt I
Search optionz Cancel |

Find where: Direction: Dptions:
" &l pages " Up [ Match case
&+ Cunent page = Down [ Find whale vword only
= Eird i

4. Typewhat you're looking for. Y ou can make your search case-sensitive or
not.

5. Notethat you can't find filesin exactly the same way as you do in Explorer...
you can't use an asterisk (*) key.

6. Click the Find in Web button to begin the search. You'll see the status of the
Web page, the last person to modify the page, and the number of times
FrontPage found the search item. If you double-click an item, FrontPage sends
you to the page.

Moving Pages

If you move pages in Windows Explorer, or anywhere else outside of FrontPage,
you'll mess up your links. If you do it within FrontPage, FrontPage will take care of
your links for you.

1. Activatethe FoldersView (View=>Folders).
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2. Click the file you want to copy in the Contents Of area.
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3. If you double-click afile from here, you'll seethat file... and be out of the
folders view. If you double-click a Folder, you'll seeits contents. Press the
Back space button to go up alevel again.

4. Drag thefile you want to copy from the Contents Of window to the folder in the
Folder List to which you want to copy the file. Asthe new file movesinto the
new folder, FrontPage recal culated the hyperlinks.

Organizing Project Pages

The Navigation View gives you avisua method of viewing your Web site, and
allows you to drag files around. To get to the Navigation View, just click on
Navigation:
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To add web pages:

1. Select the Web page you want to add to the Navigation View from the Folder
List, and drag it into the Navigation View window. FrontPage creates a proxy
view of the page with avirtual link that attached itself to the closest Web page
to the arrow cursor. Y ou can move it to other pages and change the links.

Release the mouse button to set the relationship.

. Note: if you drag a page from the Folder List onto the Navigation View
window but don't get the page close enough to another page, it will disappear.

4. Note: if you site'stoo big to view the pages vertically, right-click the Navigation
View window background and choose Rotate.
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To Add external linksin Navigation View:

External links can link either to another Web site or to an e-mail that you send. Do
this:

1. Right-click any Web page in the Navigation View window and choose Exter nal
Hyperlink from the pop-up menu to open the Select Hyperlink dialog box.

2. Enter the URL or e-mail addressin the Select Hyperlink dialog box.
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Select Hyperlink ﬂﬂ
Loak: i Ia images
| Mame | Title |
@ grallrew. gif images.zmallnew. gif
|E| undercon. gif imagesundercon. aif

URL: |www.navtech. coml j gl @ E
] I Cancel |

3. To add the e-mail address, type mailto:userid@navtech.com. Or, choose the
email icon and you'll get the Create e-mail Hyperlink dialog box and you fill in

the address.
Create E-mail Hyperlink ﬂm
Twpe an E-mail addrezs Example: someone@microsaft, com
|
] I Cancel
4. Click OK.

Print Your Web

1. Right-click the Navigation View window and chose Zoom=> Size to Fit to get
your entire site to fit on-screen.

2. Choose File=»Print Preview. If your page looks too cramped, go to File=»Page
3. Choose File=»Print and click OK.

Previewing in a Browser

FrontPage comes with its own built-in browser, which is going to look very much like
MS Internet Explorer, but it won't be identical. And it won't look at al like Netscape,
which alarge percentage of Navtech users are using. (Keep in mind that the UNIX users
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can't use Explorer.) So... you can preview your pagesin any of the browsersinstalled on
your computer... which should be both of them.

1. Switch to the FoldersView by choosing Folders.
2. Click the page that you want to preview.

3. Choose File=»Preview in Browser from the menu bar. You'll seethe Preview in
Browser dialog box.

Freview in Browser

Browser

Microzoft Internet Explorer 5.0
iMetzcape Mavigator 4.7

Edit..

LL B

[Elete

window zize

@ Default € B40x 480 © 800xE00 O 1024 4 768

[T Automatically zave page | Preview I Cloze |

4. Select the browser. Whatever browsers that FrontPage detects are there. If you
have other browsersin stalled, click Add to add them.

5. Designate awindow size by selecting one of the four radio buttons in the Window
Size area. You should choose the lowest resolution that your users might have.

6. Click Preview.

Publishing Webs

With earlier versions of FrontPage, moving Web content from your computer to aWeb
server was very frustrating. This version is much better indeed. Here are the ways you
can publish Web content now:

* Connect directly to a FrontPage server: Y our web resides on another computer
and you do all your editing and publishing while you're connected to your Web.
Thisworks in Sunnyvale, and probably Best and Chicago. With the field, it
depends on if you can see our server. In Sunnyvale, our server iscalled Lorien.

* Publishing by using HTTP. Y ou need to make sure your Web server supports
FrontPage server extensions.

1. Click File=»Publish Web. You'll get this box:
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Pablisk Web ﬂm

Specify the lozation to publizh wour web o

[t/
$ ﬂF‘F"s...l

Click here if you dan't have a web prezence provider

j Browsze... |

" Publish changed pages only

" Publish all pages. ovenwriting any already on the destination

[T Include subwebs

[T Secure connection required [S51)

Optionz + |

Publizh I Cancel

2.

3.

5.

Click the Options button. This gives you choices about publishing only
the Web pages that have been changed and other choices.

Enter the URL where you want to publish your Web content in the
Specify the Location to Publish Your Web To text box at the top. Click
the WPP's button if you aren't sureif you have the correct extensions.
Thiswill send you to the Microsoft Web site to check on the current list of
I|SP's that support the extensions. If you're not sure of the location to
publish the web, click the Browse button in the Publish Web dialog box
to search for the Open Web dialog box. Y ou can use the link buttons on
the left side of the dialog box or use the drop-down list to look for
FrontPage servers on your hard drive, on network drivers, or in your Web
folders area.

Click Publish to submit the new Web content. FrontPage tracks the
progress of the upload and shows you which pages are being transferred.
Once the upload is compl ete, an alert box appears telling you the upload is
done.

Check your site in both browsers!

* Publishing by using FTP: Thisis new and is amajor improvement. To use this
feature, you set up an FTP location, then publish the Web.

Recalculating Hyperlinks

When you move pages, images etc. around, some of the links will be broken. To
recal culate them, go to Tools=Recalculate Hyperlinks. (It will take afew minutes.)
Here'swhat thiswill do:

* Repair

all the broken hyperlinksin your Web. This means reconciling old, out-of-

date link locations with up-to-date ones.
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o Update the rest of FrontPage so that the program knows that you made changes to
your Web site. Thisis useful when using features such as Shared Borders, which
affect multiple pages.

»  Synchronize any database tables that use the new link information.

Toolbars

To get toolbars, go to View=>T oolbar s Name of toolbar. Here are the available
toolbars (and if you go to the Commands tab, there are other buttons you can use):

Toolbar Features

Standard Includes such general Office functions as Open, Save, and Print.

Formatting Provides font-style and formatting functions.

DHTML Effects | Assigns Dynamic HTML events to things like mouse clicks and
rollovers.

Navigation Lets you control the layout and size of the Navigation View. Y ou can
add external links with thistoo.

Picture Gives you point-and-click access to all the image-editing tools built
into FrontPage 2000.

Positioning Enables you to set locations and move the position of objectson a
page.

Reports Makes al the FrontPage reports accessible through a drop-down list.

Style Launches the Cascading Style Sheet dialog box.

Table Generates quick and easy HTML tables.

Reports

Y ou can generate 14 different reports in FrontPage 2000.Go to View=»Reports. You'l
get asite summary report, which includes information in 15 different categories. To get a
detailed report on one of the categories, double-click the name of the report.
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Adding Clip Art to a Page
FrontPage hasits own Clip Art Gallery to help you create buttons, banners, etc.

1. Choose Insert=»Picture=»Clip Art. You'll get the Clip Art Gallery dialog
box, which also includes sound files and video clips.
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2. Select the tab for the type of clip art you want.(Note: sound and video clips
are probably not a good idea, because they are platform-specific: aMac sound
won't work on aPC.)

3. Choose acategory of clip art. If you're looking for a specific type of image,
which as a birthday image, type birthday in the Sear ch for Clipsfield and
FrontPage will give you the clips that have that keyword.

4. Click the image you want and you'll get a floating menu to do these things:
e Insert Clip
*  Preview Clip
* Add Clip to Favoritesor Other Category
* Find similar Clips
5. You can bypass the floating menu by right-clicking and choosing I nsert.

Adding Comments

If you add comments to a Web page, they won't show up to people reading the page
unless they view the HTML code.

1. Place the cursor where you want to insert your comment, in either Normal or
HTML View.

2. Choose I nsert=»Comment from the menu bar.
Insert your text in the box.
4. Click OK.

Adding Graphics
1. Click thelocation on

the page where you Fictoms E E]
want to insert your L - A ml o =W
graphic. (If the page — [Tm |

is blank, you only K cradnse ereges/ e of

choiceistop left- Suriwzon mrogerindercon g

hand corner.)

2. Chooselnsert=»
Picture=»From file
to bring up the Insert
Picture dialog box.

3. Choose the graphic waL: | 3 @
you want. Y our
images can come [ ] e | moa | pawes. | 5em. |
from your Web,

elsawhere on your computer, or the Internet.
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Note: it'sagood ideato add all graphicsfilesto your Web before adding them to
aWeb page.

4. Click OK.

Y ou can also add graphicsin HTML view. You can do this exactly as above, or you can
actually change the HTML coding.

Using Tables

Tables are aneat way to nicely format your page. They are the best way to simulate
columns or to arrange text beside graphics. Tables can have visible lines or not.

To create atable, click the Insert Table button, drag to select the number of columns and
row you want and release. To change the Tabl€e's properties, right-click and choose Table
Properties:

Table Properties |

L apout
Aligrmert: W Specify width:
Flaat: IDefault j I'IEIEI " In pigels

¥ |n percent

Cell padding: |1 3: [ Specify height:
Cell spacing: |2 3: ||:| % [ piels

) |rpenzent

Borders

Size: |1 3: Ligft EEnder I. Autarnakic j
e I. Autarnatic j [Tk b I. Autarnatic j
B ackground

Color: I [ ] &utomatic j

T} Use Backanund petune

I Erawze,.. | Eroperties,. |

N I Convert Test To Table IS

Separate text at;

) " Paragraphs
Converting Text to a Table s
1. Highlight the text you want to convert to atable.  Commas
2. Choose Table=»Convert=»Text to Table. " None [test in single cel]

You'l get the Convert Text to Table dialog box: O Other [

3. Choose amethod to convert your text to atable
(it will depend on how you typed the data) oK. | Cancel

e Paragraphs: You'll get anew row based on a
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paragraph mark

» Tabs: You'll get anew cell in the row each timeit sees atab, and a new row
at each paragraph mark

* Commas: Sameas Tabs
* None: Puts all the highlighted text into one cell in one row.

» Other: uses acharacter marker in your text to create new rows. You'd need to
put the charactersin your data.

4. Click OK.
5. You can aso choose atable and Table=»Convert=» Tableto Text.

Create and Use Hyperlinks

Hyperlinks are the features that allow people to jump from place to place on the Internet.
Y ou can jump within a page, or to another page, or to another site entirely.

Create a Hyperlink

1. Highlight text or image that you want to be the hyperlink. Y ou can aso create a
link to a page without highlighting anything. In this case, the link would use the
title of the page that you're linking.

Create Hyperliok

3 ol o EfE

Lok i |38 myeebi

Mane | Tite -l
-Tnsu-.'.-:l fifreve_pesge ... Mew Pags 1
j T A O t s Hew Pags 2
] _pivate
| images
_'|::ed:-acl-'.l'lrn Havtech Fesdhsck Fags
(e him Hoime
[ e hims Hadaich Mavs: Page =
Yol btmn Mastech Press Flekesss 1
| el bim Hastech Freos Felesss 2
il 3 bim Havtech Press Relesss 3 _';|
al I =
wAL: [rutg:A = @l W =l o
Oiptonal
Bookmark, I|I1I:I'1!'| ﬂ Tt Frames: |F‘ug=ﬂ:lnl.i:|ru1:| il

[ = |

2. Choose Insert=»Hyperlink to get the Create Hyperlink dialog box.

Cancel |  Paamebers. |  swe. |

3. Enter thelink location in the URL field. Y ou can choose one of these methods:
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Browse your Web: Use a pull-down menu and select a page or object to link
to. Thisisthe default. Just double-click the page.

Usea Web browser. If you're linking to another Web site on the Internet,
click the globe button. Front page launches your default Web browser. Find
the page you want and go back to Front Page. The URL of the page you were
just on shows up in the URL line.

Browse your computer: Clicking the file folder with a spyglass lets you
browser your computer. When you double-click the file, the pathway to the
fileisplaced in the URL field. Thisworks well when you're linking to other
pages on the Web server, it's aterrible way to create links when publishing to
aWeb site. The path will be something like c://mydocuments/pagel. This
works great on your computer, but it won't work when someone else clicks the
link, since the file won't exist on their c: drive.

Inserting an e-mail address: If you click the e-mail button in the Create
Hyperlink dialog box, you can enter an e-mail addressto serve asthelink.
Then when a user clicks the link, the browser launches the default e-mail
client (Outlook) and inserts the address in the T o: field of a message.

Creating a new page and linking to it: Click the New Page icon which will
bring up a dialog box helping you create the new page.

Typing a URL in the box.

4. Click OK.

Create a Bookmark

Bookmarking means marking an actual spot within a Web page. Y ou'd probably do
thisif you wanted to create hyperlinks the send users to alocation on a page when

they click thelink. Bookmak __________HH|

1

In Normal View, place the Bookmark name:
cursor where you want the |T
bookmark to go.

Choose | nsert=» Bookmar k Other bookmarks on this page:
from the Menu bar. The [E[Esr |
Bookmark dialog box appears: Goto |

type a name for the bookmark
in the bookmark Name box.

Click OK. In Normal View,
you'll see an icon indicating the
location of the bookmark you

added. INnHYTML View, this 0K, | Cancel
line has been added: —

<a name = "nanme_of _bookmark"> </a>
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5. Note: If you have multiple bookmarks on a page that's quite long, you can
jump to a bookmark by bringing up the bookmark dialog box, selecting the
bookmark you want to visit, and clicking the Goto button.

Link to the Bookmark you just Created

1. ChooseInsert =»Hyperlink to get the Create Hyperlink dialog box, or press
Ctrl+K or click the hyperlink button on the toolbar.

2. Browse the Web for the page you want to link to and click it onceto select it. If
the page has a bookmark on it, the name of the bookmark snows up in the
Optional areain the Bookmark drop-down list.

3. Choose the bookmark you want.
Click OK.

Create Navigation Tools

Create Navigation Bars

1. Goto Navigation View. Make sure your Web page in included in its proper
location within the Web hierarchy.

2. Double-click the page where you want the Bar.

Choose I nsert=»Navigation Bar from the menu bar. You'll get the Navigation
Bar Propertiesdialog box:

Mavigation Bar Properties nm |
Hyperlinkz to add o page
" Parent level Additional pages:
F . " Same level ™ Home page
" Back and next [ Parert page
& Chid level
= Top level

" Child pages under Home

1 Page navigation bars will appear on
M| FPages navigation bars will link ta
[&4] Home page

1 Other pages

Orientation and appearance

I

' Horizontal ¥ Buttons
" Wertical & Text

k. I Cancel

[
O
1l

F:\engineering\webresources\frontpage.doc 40



Margie Metzer F:\engineering\webresources\frontpage.doc
(408) 822-3185; margie@netapp.com

4. Choose the appropriate hyperlink level setup for your navigation Bar:

Hyperlink Option What it Means
Parent L evel The level above the current page
Same level Any other pages at the same level as the page you're currently
working on
Back and Next The pages directly to your left and right on the same level
Child Leve Any pages for which the page in which you're inserting the

Navigation Bar isthe parent

Top Level Pages at the very top of the site, including the home page and any
others at that level

Child Pagesunder | Pageson the level below the top (home page) level
Home

5. Select abutton style in the Orientation and Appearances area of the Navigation
Properties dialog box. Y ou can use either text buttons or standard Web buttons
and change the orientation of the buttons to be horizontal or vertical.

6. Click OK

Page Banners

1. Place your cursor in the location on the page where you want to insert the
banner.

2. Choose I nsert=»Page Banner from the menu bar. The Page Banner Properties

dialog box appears.
Page Banner Properties nm

3. Select whether you want
the banner to be treated as Froperties
plain text or as an image. ol =

4. Insert atitlefor your = Teut
banner in the Page Banner
Text field. Page banner text

5. C“Ck OK. IHnme

. Note: If you'reusing

shared borders, you can set oK I Caricel
up abanner in ashared

border area, and Front Page will apply it on al the pages sharing the border.

Page Properties

Right-click on any page and choose Page Properties. You'll get the Page Properties
dialog box:
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Page Froperbies EHE
Gerwedl | Background | Cushom | Language | Wtk |
Leation [l £4VE - Frrepemtfindis bim
Ite
Bjgze location: |
Dislapull target frame: | ﬂ
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» Changea pagetitle: In General, type anew namein the Titlefield.

» Specify a default page sound. Thiswill loop continuously when the page is
loaded. (will aso probably be annoying!)

» Specify the page language: Choose the Language tab and choose the
language for the page text and the HTML coding.

» Assign categoriesto the page: used in amulti-user environment.
» Setting a background Image:
1. Select the Background tab.
2. Inthe Formatting area, select the Background Pictur e check box.

3. Click the Browse button to locate and select the background image you
want to use. Y ou can look for images on the Web or el sewhere on your
computer, but it's best to have placed them on your Web before doing this.

4. Click OK.

5. Note: If you've already set a background image for another page on your
Web site, you can use that same image for the page you're in by importing
the page settings. Check Get Background Information from Another
Page and click the Browse button to find the page.

6. Note: If you want to import a background image, your background colors
and hyperlink colors will also beimported.

7. Note: If you're using atheme, the background tab in the Page Properties
dialog box will not be there. Themes require that all the pages have the
same background settings.
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» Setting Background colors:

Click the Background tab. Y ou can choose colors for the Background, if you
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don't have a background image selected. Y ou can choose a default color for
the Text on your Web page, or Hyperlinks (not a good idea; people are used
to blue); or visited hyperlink (ditto, they're used to purple), or Active
Hyperlink.

Text Attributes

FrontPage 2000 looks alot like Microsoft word in terms of changing text attributes. In
order to make this happen, however, they've created a situation where alarge number of
attributes won't work on older browsers, including Netscape Navigator 3.0 (and below),
and Internet Explorer 3.0 and lower. Basically, changes other than bold, Italic and
alignments won't show up at al on older browsers. Theitems I'll describe below are fine
with older browsers, as |'ve elected not to include things that won't work for the vast
majority of our users.

Most of the text attributes are based on the HTML 3.2 and Cascading Style Sheets 2.0
specification. But these standards are only fully supported by Netscape Communicator
4.0 and up, and Internet Explorer 4.0 and up.

To change an attribute, select the test and select the right button.

Changing Font Properties
1. Highlight the text you want to change.
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2. Choose For mat=>»Font from the menu bar. The Font dialog box appears.

3 IO e, oL Can g N o [ |

Fort | Crassctes Soacing |

type, style, color, and size, as
well as character position,
spacing, and some special
effects.

4. IMPORTANT NOTE: When
you change fonts through the
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selecting fonts that are installed Effects
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This means whatever fonts you - e - Faie - Ktbend

choose beside Times new
Roman and courier will not only
not be seen by the UNIX and EHEE AaBbYyGgLLyj S
Mac computers, but your page
setup and alignment will most
likely be upset aswell.

Also... most of the Effects
items are not viewable by 3.0 and lower browsers.

5. Click OK.

Using Graphics with MS Image Composer

MS Image composer is a software package that comes with FrontPage 98 and FrontPage
2000. It will allow you to perform some basic editing functions on graphics for your Web
site, and particularly, convert filesto .GIF or .JPG files.

The Image composer refersto a drawing object as a Sprite. Thisisknown asaLayer in
other graphic applications.

Image composer lets you work with several types of file formats, including TIFF (.tif,
Tagged Image format), CompuServe GIF (.gif), Targa (.TGA), JPEG (.Jpg), Windows
bitmap (.bmp), and Adobe PhotoShop 3.0.(.psd).

It supports the TWAIN interface so you can use it to scan images.

Parts of the Screen
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Starting Microsoft Image Composer

While you're in FrontPage, you will open MI1C when you double-click a.gif or .jpg
image. Y ou can aso open it from the Program menu, and either Insert Image File or just
open an image.

Drawing Shapes

Y ou can only Save stuff that's in the composition space, though you can draw things
on the edges.
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Draw a Red Square
Click the color swatch

Choose red

Click the Shapes palette

Click the rectangle button

Make sure Opacity is 100, and the edgeisHard

Drag from one corner to another to draw a rectangle, hold down the shift key for
asguare

7. Click Create

© 0o & W DN PR

Draw a Blue circle
1. .Change color to blue

2. Click oval button
3. Keep the opacity at 100, but change the edge to Soft
4

. Drag from one corner to another to draw an oval, hold down shift key for a
circle.

5. Click Create

Draw a curved shape
1. Chooseacolor

Click the Curve button

Change the Opacity to 501, and set the edge back to hard
Click the first point, then the second, then the third
Click Create

a WD

Draw a Polygon
1. Choose adifferent color

2. Click the Opacity to O
3. Click thefirst point, then the second, then the third
4. Click create: note that with O opacity you get nothing

Moving Shapes
1. Click onashape
2. Dragit or use the keyboard's arrow keys to move it to the desired location
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Bringing a Shape Forward or Backward
1. Place one shape on top of another

2. Right-click on the sprite
3. Select Bring to Front, or Send to Back

Rotating a Shape
1. Select ashape

2. Usethetop right shape handle to rotate the shape

Changing the Shape's Color
1. Select a Shape

2. Sdect acolor from the color swatch
3. Click the Color Fill button on the tool bar

Inserting and Manipulating Pictures

Insert a Rabbit
1. Select Insert=»Clip Art

2. Click the Picturestab. Type Rabbit in the box next to Search for Clips. Choose a
rabbit

3. Click Insert
Drag the size handle to resize the rabbit
5. Move the rabbit into the white composition space

Insert a Lion
Do the sametoinsert alion.

Flip an Image
Select the rabbit

Click the Arrange palette on the toolbox
Click theflip horizontal button
Click Apply and close the Arrange palette.

A WD P

Delete an Object
1. Select the rabbit.

2. Zoominto 300%
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Select the Cutout palette.

Select the Cutout Tools tab.
Select the Curvetool.

Click dots around the rabbit's tail.

N o g kM~ w

Click Erase on the cutout palette.

Cut out an object and Place it Elsewhere
Select thelion

On the toolbar, change the zoom to 300%

Click the cutout palette

Choose the polygon tool

Click dots around the lion's tall

Click Cut Out on the cutout palette.

Movethetail to the end of the rabbit. (Y ou may want to rotate it.)
Change the zoom back to 100%

© N o g b~ w D P

Combine Two Images
1. Click the rabbit.

2. Press Shift and click the new lion's tail. Both should be selected.
3. Right-click on the rabbit and choose Group.

Saving an Image

Resize the Composition Area
1. Select the top edge of the composition area

2. Click and drag down, so it isno taller than the tallest sprite.
3. Repeat the process for the bottom, left and right sides of the composition area.

Save as a Microsoft Image Composer (MIC) file
1. Select File=»Save

2. Make sure the Save Astypeis Microsoft | mage Composer.
3. TypeaFilename.
4. Click Save.
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Save an Image for the Web
1. Sdect File=»Savefor the Web.

2. Choose All Spritesinside the composition area, then click Next.

3. Choose L et the web page background show through, so the white areawill be
transparent.

4. Choose on of these options, then choose Next.

» My Web page's background isthefollowing solid color, and then select
the color.

» My Web page's background isatiled image.
Review the status of your image, then click Save.
Enter the file name for your image.

Optiona: click on the transparent color to changeit.
Click Save.

© N o O

More about Graphic files
* Youwill typically save photos as .jpg files, and graphics with solid colors as gifs.

» Graphicsload more slowly than text, because of the size of the files. Loading
speed is dependent on these items:

» Server speed
* Number of concurrent users
» Sizeof graphic
*  Modem speed
» Toreducefile size (colors x width x height):

* Reduce the number of colors
* Reducetheimage size

* A goodimagesizeis50K or less.

Other Ways to Edit Images in FrontPage 2000

Activating the Picture Toolbar
Go to View=>Toolbar s Pictures
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Auto thumbnails

An Auto Thumbnail is a handy tool that enables you to create a min-version of a picture.
Y ou can then use an image as a button that links to alarger version of the picture. To
create one, click and image and then click the Auto Thumbnails button on the Picture
toolbar. (See above.)

When you create a thumbnail and save the page, FrontPage prompts you to save the new
thumbnail you created. When you load the page in a browser, you see the thumbnail and
not the original image. When you click the thumbnail, the larger version appearsin the
Web browser.

Y ou can change the size, borders, and add a bevel by going to T ools=»Page Options=
AutoT humbnail.

Beveling an Image

Beveling adds a border and three-dimensional depth to a graphic, so that it looks like a
button.

In Normal, click the image.

2. Click the Bevel button on the Pictur e toolbar. The button adds a bevel to your
graphic:
3. Click the Bevel button again to make the bevel darker and add more emphasis.

F:\engineering\webresources\frontpage.doc 50



Margie Metzer F:\engineering\webresources\frontpage.doc
(408) 822-3185; margie@netapp.com

|
Brightness and Contrast

Changing a graphic's brightness makes the graphic appear lighter or darker. Changing the
graphic's contrast make the pixels stand out more or become more muted. Usually,
contrast and brightness go hand in hand.

Click the image and press the Contrast or Brightness. Y ou can aso get a bleaching
effect by clicking the Wash Out button.

Cropping

Cropping reduces the amount of an image you see on the screen by eliminating part of it.
For instance, you could crop out your ex-husband in adigital photo of the two of you.
Y ou can only crop rectangular areas..

Click the image, then the Crop button, then click the anchor points and move the
rectangle around if you want to resize the cropping area. Press the Crop button once
more to do the actual cutting. Press Esc to desel ect the cropping tool.

Flipping and Rotating Images

Click the graphic that you want to flip or rotate. Click the Rotate L eft, Rotate Right,
Flip Horizontal, or Flip Vertical button.

Hyperlink to an Image

In Normal view, click the image. Choose | nsert=»Hyperlink from the menu bar (or
press Ctrl+K). type the URL you want the image to link to.Click OK.

Image Maps

Image Maps are navigation tools in which a big graphic (say a map) contains a series of
hot links to various locations. Y ou create these by specifying regions of a graphic and
then setting links for the regions.

1. InNormal view, click the graphic for which you want to create an image map.

2. Select one of the image map shape tools from the Picture Toolbar: Rectangular,
Circular, or Polygonal Hotspots. Create the shape that you want as alink using
the tool. Now you'll get the Create Hyperlink dialog box.

3. Typethelink inthe URL text box or use the drop-down list in the Create
Hyperlink dialog box.

4. Click OK.

Transparent GIFS

Y ou cam make a GIF file have a transparent background if you want. Essentially, you
make a particular color invisible.

1. Click theimage
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2. Click Set Transparent Color on the Pictur e toolbar.
3. Click the color on the image that you want to make transparent.
All instances of that color will now be invisible.

Note: If you're using other image types in your Web page, FrontPage will try to turn that
image into a.gif file when you click the Set Transparent Color button on the Picture
Toolbar. You can set on one transparent color with thistool. If you select this tool again,
that color becomes the transparent color and the one you chose before is no longer
transparent.
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Appendices

Useful Sites
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